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安全情報 

 

法規制の順守 

CY15FRAMKIT-001 シリアル F-RAM™開発キットは、実験室環境でハードウェアまたはソフトウェア用のシリアル メモリ開発プ

ラットフォームとして使用されます。このボードは、保護カバーを含まないオープンシステム設計です。そのため、この基板は近くに

ある他の電子・電気機器と干渉する可能性があります。  

この基板に追加の配線を取り付けるか、工場出荷時の設定から製品の動作を変更すると、性能に影響を及ぼし、すぐ近くにある

他の装置に干渉する可能性があります。そのような干渉が検出された場合、適切な解決策を実行すべきです。 

工場出荷時の CY15FRAMKIT-001は、クラス Aの製品として CEの要件を満たすことが確認されています。 

 

 

CY15FRAMKIT-001 は ESD に弱いデバイスを含んでいます。静電気は人体やあらゆる装置に簡単に蓄

積し、検出されず放電することがあります。高エネルギー放電にさらされたデバイスが完全に損傷する場合

があります。適切な ESD 保護が、性能低下または機能喪失を防止するために推奨されます。

CY15FRAMKIT-001 基板は、使用しない時には出荷時に使われていた保護パッケージに格納してくださ

い。 

 

寿命／製品リサイクル  

このキットの製品寿命は、箱の裏側に記載される製造日から 5 年です。キットの廃棄については、最寄り

のリサイクル業者にお問い合わせください。 
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一般的な安全上の注意 

ESD保護 

ESD は基板および関連のコンポーネントを破損する可能性があります。サイプレスは、ユーザーが ESD ワークステーションでの

み ESD テスト手順を実行することを推奨します。ESD ワークステーションがない場合、部品を取り扱う時には、基板のシャーシ 

グランド (あらゆる塗装されていない金属面) に接続されている静電気除去リストストラップを身に着けて、適切な ESD保護を

行ってください。 

基板の取り扱い 

CY15FRAMKIT-001 基板は ESD に弱いです。基板を持つ時は基板の縁だけを持ってください。箱から基板を取り出したら、接

地され静電気のない面に置いてください。可能であれば導電性フォームパッドを使用してください。どんな表面であっても、基板を

滑らせないでください。 
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1.   はじめに 

 

CY15FRAMKIT-001 シリアルF-RAM開発キット (DVK) にご興味をお持ちいただきありがとうございます。キット (シールド) は使い
やすい、且つ安価な開発キットとして設計され、サイプレスのシリアル強誘電体ランダム アクセス メモリ (F-RAM) の機能を示しま
す。 柔軟性を持つように設計されたため、このキットは、CY8CKIT-042 PSoC

®
 4 Pioneer Kit、CY8CKIT-040、CY8CKIT-042 

BLE、サードパーティ製のArduino™ UNO R3、および他のいくつかのArduinoキットとのフットプリント互換性を持っています。この
基板は、256KビットのSPI F-RAM、256KビットのI

2
C F-RAM、I

2
C F-RAMデバイス選択ピンを制御するためのスリーポール DIPス

イッチ、Arduino UNO互換ヘッダ、および2個のデバッグ ヘッダを含んでいます。このキットは5.0Vまたは3.3Vの電源電圧に対応し
ます。 

 

CY15FRAMKIT-001はサイプレスのシリアルF-RAMメモリ用の開発キットです。サイプレスのF-RAMは強誘電体技術に基づい
て構築され、高性能RAMに不揮発性データ ストレージを組み合わせたメモリです。シリアルF-RAMはフル スピードのバスで高速
書き込みを実現します。書き込み遅延がなくデータが瞬時に不揮発性になります。これは、アクティブ電流が300μA、スタンバイ電
流が6μAという低消費電力なメモリです。書き込み速度が高速のため、アクティブになる短い時間のみで非常に低いエネルギーを
消費します。事実上100兆回の読み出し／書き込みサイクルという無限の耐久性を提供しています。  

 

1.1   キットの内容 

CY15FRAMKIT-001シリアル F-RAM DVKは 11-1に示しているように、以下のものを含んでいます。 

 CY15FRAMKIT-001シリアル F-RAM DVK基板 

 クイックスタート ガイド 

11-1. CY15FRAMKIT-001シリアル F-RAM DVKの内容物 

 

詳細については、www.cypress.com/shop をご覧ください。 キットの内容を確認し、部品が欠落している場合、最寄りのサイプレ

ス販売代理店にお問い合わせください。 

http://www.cypress.com/shop/
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1.2   PSoC Creator™ 

PSoC Creator は最先端の、使いやすい統合設計環境 (IDE) です。これは、事前検証および事前に特性確認された PSoC 

Component ™のライブラリに基づく、革命的なハードウェアとソフトウェアの協調設計を紹介します。 

PSoC Creatorにより、以下のことが可能です。 

 PSoCコンポーネントをドラッグ アンド ドロップして、カスタム設計の回路図を作成する 

 コンポーネントを自動的に配置して配線し、 GPIOを設定する、 

 備えているコンポーネント API でファームウェアを開発しデバッグする 

また、PSoC Creatorにより、ユーザーは、PSoCデバイス用の結合コンパイラ チェーンやプロダクション プログラマを含む全体
ツール体系を活用できます。詳細については、www.cypress.com/Creatorをご覧ください。 

1.3   はじめよう 

このガイドはユーザーがシリアルF-RAM DVKに慣れるのに役立ちます。「キットのインストール」章はキット ソフトウェアのイン

ストールについて述べます。「キットの概要」章はキットの機能について説明します。「ハードウェア」章はハードウェア動作を詳しく

述べます。「サンプル プロジェクト」章はサンプル コードを記述します。付録の節では、回路図、ピンの割当て、0オームと30オー

ム抵抗の使用、および部品表 (BOM) を述べます。 

1.4   追加の学習資料 

データシートとアプリケーション ノートの追加学習資料は、www.cypress.com/go/F-RAM をご覧ください。ベースボードに関連す
るリソースは以下から入手できます。 

 PSoC 4 Pioneer Kit (CY8CKIT-042)   

 Arduino UNO R3 

1.5   テクニカル サポート 

支援が必要な場合、www.cypress.com/supportのサポート ウェブページをご覧いただくか、+1(800)541-4736内線 2 (米国) あ

るいは+1 (408) 943-2600内線 2 (米国外) にお電話の上、カスタマ サポートにお問い合わせください。 

1.6   本書の表記法  
表 1-1. 本書の表記法 

表記法 使用法 

Courier New フォント ファイルの場所、ユーザーが入力したテキストおよびソースコードを示す: 

C:\...cd\icc\ 

イタリック フォント ファイル名および参考文献を示す: 

PSoC Designer User Guideにある sourcefile.hex ファイルを参照してください。 

[角括弧、太字] 操作手順でキーボードに入力するコマンドを示す: 

[Enter] または [Ctrl] [C] 

File > Open メニュー パスを示す: 

File > Open > New Project 

太字 操作手順でのコマンド、メニューパス、アイコン名を示す: 

Fileアイコンをクリックしてから、Openをクリックします。 

Times New Romanフォント 式を示す: 

2 + 2 = 4 

灰色のボックス内のテキスト 製品の注意点や製品固有の機能を説明 

http://www.cypress.com/Creator
http://www.cypress.com/go/F-RAM
http://www.cypress.com/?rID=77780
http://arduino.cc/en/Main/arduinoBoardUno
http://www.cypress.com/go/support
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2.   キットのインストール 

 

 

本節では CY15FRAMKIT-001シリアル F-RAM DVKソフトウェアのインストールおよび前提条件について述べます。 

2.1   必須なソフトウェア 

キットを使用する前に、PSoC Creator IDE または Arduino IDEをインストールする必要があります。サイプレスの全てのソフト

ウェアのインストールは管理者特権が要求されます。インストール後のソフトウェア実行は管理者特権を必要としません。サイプレ

スが提供するソフトウェアが実行中であれば、キット ソフトウェアをインストールする前に全て終了してください。 

PSoC Creator IDEをダウンロードするには、www.cypress.com/psoccreatorにアクセスしてください。 

Arduino IDEをダウンロードするには、arduino.cc/en/Main/Softwareにアクセスしてください。 

2.2   キットソフトウェアのインストール 

CY15FRAMKIT-001シリアル F-RAM DVKソフトウェアをインストールするには以下の手順に従ってください。 

1. www.cypress.com/go/CY15FRAMKIT-001 から CY15FRAMKIT-001 DVK ソフトウェアをダウンロードします。

CY15FRAMKIT-001ソフトウェアが 3つの異なるフォーマットで提供されます (図 2-1を参照): 

図 2-1. ダウンロード時のシリアル F-RAM DVKソフトウェアの可能なフォーマット 

 

 CY15FRAMKIT-001 Kit Setup: この実行ファイルはキットのサンプル コード、ハードウェア ファイルおよびユーザー ド

キュメントを含むキットの内容物のみをインストールします。 

 CY15FRAMKIT-001 CD ISO: このファイルは、CDを作成するか、またはWinZipやWinRARなどの ISO抽出プロ

グラムで抽出するのに使用できる CD-ROMイメージ フォーマットで保存される完全なパッケージです。また、ファイル

は、Virtual CloneDriveとMagicISOなどの仮想ドライブ プログラムで仮想 CDのように取り付けることができます。こ

のファイルは必要なファームウェア、ハードウェア ファイル、およびユーザードキュメントを全て含んでいます。 

2. CD ISO ファイルを既にダウンロードした場合、仮想ドライブにロードしてください。仮想ドライブがない場合、ISO ファイルの

内容を解凍してください。「CD/DVD から自動実行」が PC で有効にされていない場合、解凍した内容または取り付けた ISO

のルート ディレクトリでの cyautorun.exe をダブルクリックします。図 2-2 に示すインストール ウィンドウは自動的に表示さ

れます。  

注: 「Kit Setup」ファイルを使用している場合、インストールするにはステップ 3 に進んでください。 

3. 図 2-2に示すように、キット起動画面が表示されます。 インストールのデフォルト ロケーションは Program Filesフォルダ下

の Cypressフォルダです。  

(a) 

(b) 

http://www.cypress.com/psoccreator
http://arduino.cc/en/Main/Software
http://kohima.ad.iwpc.cypress.com/updates/cy15framkit/1.0/CY15FRAMKITSetup.exe
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図 2-2. キット インストーラの起動画面 

 

CY15FRAMKIT-001 キット関連のファイルをインストールしたいフォルダを選択します。ディレクトリを選択して Next をクリッ

クします。 

4. 図 2-3に示すように、Product Installation Overviewウィンドウで Typical installation タイプを選択します。「Next」をク

リックします。 

図 2-3. 「Product Installation Overview」ウィンドウ 
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インストールが開始されたら、パッケージの一覧がインストール ページに表示されます。インストールが完了すると、緑色の

チェックマークが各パッケージのそばに表示されます。 

5. ユーザーが初めてインストールするサイプレスの製品であれば、ユーザーの連絡先情報を入力するか、または Continue 

without Contact Informationオプションを選択します。Finish をクリックして CY15FRAMKIT-001キットのインストールを

完了します。 

インストールが完了した後、キットの内容物は <Install_Directory>\CY15FRAMKIT-001 Serial F-RAM 

Kit\1.0 に格納されます。デフォルトのロケーションは次のとおりです。 

 Windows 7 (64ビット) の場合: C:\Program Files (x86)\Cypress\CY15FRAMKIT-001 Serial F-RAM 
Kit\1.0 

 Windows 7 (32ビット) の場合: C:\Program Files\Cypress\CY15FRAMKIT-001 Serial F-RAM Kit\1.0 

注: Windows 7/8/8.1ユーザーに対しては、インストールしたファイルとフォルダは読み出し専用です。プロパティを変更する

にはフォルダを右クリックして、Properties > Attributesを選択して Read-only オプションを無効にします。.Apply と OK 

をクリックしてウィンドウを閉じます。 

インストールが完了した後、以下のものがユーザーのコンピューターにインストールされす。 

 キットの文書 

 クイック スタート ガイド 

 キット ガイド 

 リリース ノート 

 ファームウェア 

 PSoC 4 F-RAM SPIサンプル プロジェクト 

 PSoC 4 F-RAM I2Cサンプル プロジェクト 

 Arduino UNO F-RAM SPIサンプル プロジェクト 

 Arduino UNO F-RAM I2Cサンプル プロジェクト 

 ハードウェア 

 回路図 

 レイアウト 

 ガーバー 

 PCB組み立て図面 

 部品表 (BOM) 

2.3   ソフトウェアのアンインストール 

ソフトウェアをアンインストールするには、以下の方法の 1つを使用します。 

 Start > Control Panel > Programs and Featuresに進んで、対象のソフトウェア パッケージを選択して Uninstall をク

リックします。 

  Start > All Programs > Cypress > Cypress Update Manager > Cypress Update Managerに進みます。 

 「CY15FRAMKIT-001 Serial F-RAM Kit 1.0 Rev **」を選択して、Uninstallをクリックします。Product Installation 

Overviewウィンドウで、Installation Type ドロップダウン メニューから Removeを選択します。指示に従ってアンイン

ストールします。 

注: この方法では、キット ソフトウェアのみがアンインストールされ、キット ソフトウェアとともにインストールされた他のソフト

ウェアはアンインストールされません。 
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3.   キットの概要 

 

3.1   CY15FRAMKIT-001シリアル F-RAM開発キット の概要 

CY15FRAMKIT-001シリアル F-RAM DVKはシリアル F-RAM (SPIおよび I
2
C) の機能を理解するために使用することができま

す。DVKは 256Kビットの SPI F-RAMおよび 256K ビットの I
2
C F-RAMを搭載するシールド基板です。この基板には Arduino 

UNOと互換性がありサイプレスの PSoC 4 Pioneer Kitまたは Arduino UNO R3基板のどちらかに接続するコネクタが 4個あり

ます。これらのコネクタはスタック可能ですので、Arduino と互換性のあるその他のシールドをコネクタにスタックすることができま

す。このキットは 3.3Vまたは 5.0Vで動作します。図 3-1に DVK基板およびその概要を示します。 

図 3-1.DVK 基板の概要 

 

 

 

                             

 

 

 

「A.5 30Ω抵抗と負荷なしの使用法」節を参照して、2個の 30Ω抵抗を取り付けて、CY15FRAMKIT-001ハードウェアを

Arduino UNO R2と互換性のあるハードウェアにします。 
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3.2   キットの動作およびコンフィギュレーション ガイド 

3.2.1   電源供給ジャンパ 

図 3-2に示すように、CY15FRAMKIT-001はジャンパ J5経由の選択で 3.3V と 5.0Vのどちらかで動作できます。工場出荷時

のジャンパのデフォルト設定は 5.0Vです (ピン 1 とピン 2を短絡)。Arduino UNO R3基板は 5.0Vで動作し、ジャンパ J5のデ

フォルト設定を適用します。CY8CKIT-042 Pioneer Kitは 3.3V と 5.0Vのどちらかで動作します。Pioneer Kitのデフォルト設定

は 3.3Vです。よって、親基板の電圧設定により、ジャンパ J5を 5.0V (ピン 1とピン 2を短絡) または 3.3V (ピン 2とピン 3を短

絡) に設定します。 

注意 

1. 外部電源から CY15FRAMKIT-001基板に電源を供給しないでください。この基板は親基板から
電源供給されるように設計されています。 

2. CY15FRAMKIT-001は 2.7Vから 5.5Vまで動作します。最大電圧制限 (5.5V) を超えると基板が
破損する可能性があります。  

3. 基板が正しく動作するために、親基板の動作電圧に一致するようにジャンパ J5が設定されること
を確保してください。 

図 3-2. 電源選択ジャンパ 

 

3.2.2   F-RAMデバイス 

図 3-3. 基板上のサイプレスのシリアル F-RAMデバイス 

 

3.2.3   I2C F-RAMデバイスのスレーブ アドレス選択用の DIPスイッチ 

図 3-4に示すように、DVKは、個別のスレーブ選択アドレス ピン (A2～A0) を論理 LOW「0」または論理 HIGH「1」に割り当てる

ことで I
2
C F-RAM用の異なるスレーブ アドレスを設定するための DIPスイッチ オプションを提供します。DIPスイッチはオン位置

電源選択ジャ

ンパ (J5) 

256Kビットの
SPI F-RAM 
(U1) 

256Kビットの
I
2
C F-RAM 

(U2) 
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の場合、4.7kΩのプルアップ抵抗を使って対応するスレーブ選択アドレス ピンを論理 HIGHに維持します。DIPスイッチはオン位

置にない場合、対応するスレーブ選択アドレス ピンが F-RAM デバイスにより、内部弱プルダウン抵抗を介して論理 LOW に維

持されます。工場出荷時の DIP スイッチのデフォルト設定はオン位置にないので、A2、A1 と A0 の値が論理 LOW「0」に設定さ

れます。  

図 3-4. I
2
C F-RAMの A0、A1と A2設定用の DIPスイッチ 

 

3.2.4   CY8CKIT-042/Arduino UNO R3 基板へのコネクタ 

図 3-5に、CY8CKIT-042/Arduino UNO R3 基板への Arduino-互換のコネクタ (J1、J2、J3と J4) を示します。ユーザーはこれ

らのコネクタを介して DVK基板を CY8CKIT-042/Arduino UNO R3基板に接続することができます。回路図の詳細については、

17ページの「ハードウェア」章を参照してください。 

図 3-5. CY8CKIT-042/Arduino UNO R3基板へのコネクタ 
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3.2.5   デバッグ ヘッダ 

デバッグ ヘッダは SPI と I
2
C通信ピンへの簡単なアクセスのために提供されます。図 3-6に示しているように、ジャンパ J6はイ

ンサーキット シリアル プログラミング (ICSP) ヘッダ ピンのレイアウトに従って、SPI信号へのアクセスを提供します。ジャンパ J7

は SPI F-RAMデバイスのチップ選択信号および I
2
C通信信号へのアクセスを可能にします。 

図 3-6. デバッグ ヘッダ 

 

 

3.2.6   テスト ポイント 

図 3-7に示すように、DVK基板は VDD (TP3) および GND (TP1と TP2) テスト ポイントを提供します。  

図 3-7. テスト ポイント 

 

 

注意 
これらのテスト ポイントは調査と測定の目的に限って使用されます。基板が損傷しないように、これらのテス
ト ポイントを使ってキットに電源を供給しないでください。 

 

3.3   PSoC 4 Pioneer Kitに接続した CY15FRAMKIT-001 

CY15FRAMKIT-001は J1、J2、J3と J4という 4個のコネクタを介して PSoC 4 Pioneer Kit (CY8CKIT-042) に接続されます。

シリアル F-RAMキットのデフォルトの動作電圧は 5.0Vです。この動作電圧に一致させるために、PSoC 4 Pioneer Kitの電圧設

定を 5.0Vに変更します。ユーザーは PSoC 4 Pioneer Kitとシリアル F-RAMキットの両方で 3.3Vの電源設定を選択することで、

これらのキットを 3.3Vで動作させることもできます。 

注: CY15FRAMKIT-001での J2は 6ピンの単列ジャンパです。PSoC 4 Pioneer Kitでは、J2は 9x2のヘッダです。したがって、

CY15FRAMKIT-001 の J2 は Pioneer 基板上の J2 ヘッダの外側列の左端にある 6 個のピンに差し込まれます。

CY15FRAMKIT-001が一方向でのみ挿入可能なので、その事を簡単に認知できます。 

デバッグ ヘ
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デバッグ / Arduino互換
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図 3-8. PSoC 4 Pioneer Kitに取り付けた CY15FRAMKIT-001 

 

3.4   Arduino UNO R3キットに接続した CY15FRAMKIT-001 

CY15FRAMKIT-001は J1、J2、J3と J4という 4個のコネクタを介して Arduino UNO R3キットに接続されます。これらのコネク

タ ピンは 1対 1でマッピングされます。 

図 3-9. Arduino UNO R3キットに取り付けた CY15FRAMKIT-001 
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4.   ハードウェア 

 

4.1   基板の詳細 

図 4-1に示しているように、CY15FRAMKIT-001シリアル F-RAM DVKは以下のブロックを含んでいます。 

 256Kビットの SPI F-RAM (U1) 

 256Kビットの I2C F-RAM (U2) 

 電源選択ジャンパ (J5) 

 電源 LED (LED1) 

 デバイスのアドレス選択用の DIPスイッチ (SW1) 

 SPI/I2C信号用のデバッグ ヘッダ (J6, J7) 

 Arduino互換コネクタ (J1、J2、J3、J4) 

図 4-1. CY15FRAMKIT-001シリアル F-RAM DVKの詳細 
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図 4-2. CY15FRAMKIT-001シリアル F-RAM DVKと PSoC 4 Pioneer/Arduino UNO R3キットのピン マッピング 
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4.2   動作理論 

本節では、PSoC 4 Pioneer Kitをブロック レベルで説明します。 

図 4-3. ブロック図 

 

CY15FRAMKIT-001 シリアル F-RAM DVK は 256K ビットの SPI および 256K ビットの I
2
C F-RAM デバイスを提供します。

DVKは PSoC 4 Pioneer Kitまたは Arduino UNO R3キットに差し込むことができるシールド基板です。 

CY15FRAMKIT-001 シリアル F-RAM DVK は電源オンの状態を示す電源 LED (LED1) を備えています。キットはジャンパ J5

経由の選択で 3.3Vと 5.0Vのどちらかで動作できます。また、このキットは I
2
C F-RAMのデバイス アドレスを変更できます。さら

に、キットは SPI／I
2
C信号用のデバッグ ヘッダを提供します。 

4.3   機能の説明 

4.3.1   SPI F-RAMデバイス (256Kビットの FM25W256) 

CY15FRAMKIT-001シリアル F-RAM DVKはサイプレスの 256K ビットの SPI F-RAMデバイスを使用します。Arduino互換

ヘッダを介したデバイス ピンへの読み出しと書き込みアクセスが可能です。  

特長 

 32K×8構成の 256Kビット強誘電体 RAM (F-RAM) 

 高いアクセス可能回数: 100兆 (10
14

) 回の読み出し／書き込み 

 151年のデータ保持期間 

 NoDelay™書き込み 

 信頼性の高い強誘電体プロセスを使用 

 高速シリアル ペリフェラル インターフェース (SPI) 

 最大 20MHzの周波数 
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 シリアル フラッシュおよび EEPROMからの置き換え 

 SPIモード 0 (0、0)  および SPIモード 3 (1、1)  をサポート 

 洗練された書き込み保護スキーム 

 書き込み保護 ( ) ピンを使用したハードウェアによる保護 

 書き込みディスエーブル命令を使用したソフトウェアによる保護 

 アレイの 1/4、1/2、または全体を対象としたソフトウェア ブロック保護 

 低消費電力 

 アクティブ モードの時、1MHzで 250µAの電流を消費 

 スタンバイ モードの時、15µA (標準) の電流を消費 

 広い範囲の動作電圧: VDD = 2.7V～5.5V 

 産業用途向け温度範囲: –40ºC～+85ºC 

 8ピン小型集積回路 (SOIC) パッケージ 

 RoHS準拠 

メモリの書き込み 

SPI F-RAMへの書き込みはすべてWREN (書き込みイネーブル) オペコード (0x06) から始まります。WRITEオペコード (0x02) 

の後に、メモリへ書き込む最初のデータ バイトを指定する 15 ビット アドレス (A14～A0) を含む 2バイト アドレスが続きます。2

バイト アドレスの上位ビットは無視されます。アドレスの 2 バイトの後に続くバイトは順次に書き込まれるデータ バイトです。バス 

マスターがクロックを送り、 を LOW に維持している限り、アドレスは内部でインクリメントされます。7FFFh の最終アドレスに達

すると、カウントは 0000h に戻ります。データは MSB から書き込みます。 の立ち上がりエッジで書き込み動作を終了します。

SPI F-RAMの書き込み動作は下図に示します。 

図 4-4. SPI F-RAM メモリ書き込み 

 

図 4-5. SPI F-RAM メモリ書き込み 

 

メモリ読み出し 

の立ち下がりエッジの後に、バス マスターは READ オペコード (0x03) を発行できます。READ コマンドの後には、読み出し

動作の開始バイトを指定する 15ビット アドレス (A14～A0) を含む 2バイトのアドレスが続きます。アドレスの上位ビットは無視さ
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れます。READオペコードとアドレスの 2バイトが発行された後、デバイスは SO ピンの次の 8つのクロックで読み出しデータ バ

イトを出力します。SI 入力は読み出しデータ バイトの出力中には無視されます。後続のバイトは順次に読み出されるデータ バイ

トです。バス マスターがクロックを送り、 が LOW である限り、アドレスは内部でインクリメントされます。7FFFh の最終アドレス

に達すると、カウントは 0000h に戻ります。データは MSB から読み出します。 の立ち上がりエッジで読み出し動作を停止し、

SOピンをトライステートにします。SPI F-RAMの読み出し動作は下図に示します。 

図 4-6. SPI F-RAM メモリ読み出し 

 

ステータス レジスタ書き込み 

ステータス レジスタ書き込みWRSRコマンド (0x01) により、SPIバス マスターが SPI F-RAMのステータス レジスタに書き込む

ことができます。 

図 4-7. SPI F-RAMステータス レジスタ書き込み 

 

ステータス レジスタ読み出し 

ステータス レジスタ読み出しRDSRコマンド (0x05) により、バス マスターはSPI F-RAMのステータス レジスタの内容を検証する

ことができます。ステータス レジスタを読み出すことで、書き込み保護機能の現時点の状態に関する情報を得ます。RDSRオペ

コードに続いて、SPI F-RAMデバイスはステータス レジスタの内容を持つ1バイトを返します。 
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図 4-8. SPI F-RAM ステータス レジスタ読み出し 

 

F-RAMデバイスの詳細については、「FM25W256データシート」を参照してください。 

4.3.2   I2C F-RAMデバイス (256Kビットの FM24W256) 

CY15FRAMKIT-001シリアル F-RAM DVKは 256Kビットの I
2
C F-RAMデバイスを使用します。Arduino互換ヘッダを介したデ

バイスへの読み出しと書き込みアクセスが可能です。  

特長 

 256Kビットの F-RAMは論理的に 32K × 8として構成 

 高いアクセス可能回数: 100兆 (1014) 回の読み出し／書き込み 

 151年のデータ保持期間 

 NoDelay™書き込み 

 信頼性の高い強誘電体プロセスを使用 

 高速 2線式シリアル インターフェース (I
2
C) 

 最大 1MHzの周波数 

 シリアル (I
2
C) EEPROMからの置き換え 

 100kHzと 400kHzに応じた従来のタイミングに対応 

 低消費電力 

 アクティブ モードの時、100kHzで 100µAの電流を消費 

 スタンバイ モードの時、15µA (標準) の電流を消費 

 広い範囲の動作電圧: VDD = 2.7V～5.5V 

 産業用途向け温度範囲: –40ºC～+85ºC 

 8ピン小型集積回路 (SOIC) パッケージ 

 RoHS準拠 

スレーブ デバイス アドレス 

START 条件後に FM24W256 が待ち受けている最初のバイトはスレーブ アドレスです。図 4-9 に示すように、スレーブ アドレ

スはデバイス タイプまたはスレーブ ID、デバイス選択アドレス ビット、およびトランザクションが読み出しか書き込みかを指定する

ビットから成ります。 ビット 7～4はデバイス タイプ (スレーブ ID) であり、FM24W256の場合は 1010bにセットする必要がありま

す。これらのビットにより、他の機能タイプが同じアドレス範囲の I
2
C バス上に存在することができます。ビット 3～1 はデバイス選

択アドレス ビットです。デバイスを選択するには外部アドレス ピンの値と一致させる必要があります。各デバイスに異なるアドレス

を割り当てることで、最大 4 個の FM24W256 デバイスが同じ I
2
C バス上に存在できます。ビット 0 は読み出し／書き込みビット 

( ) です。  = 「1」は読み出し動作を、  = 「0」は書き込み動作を示します。 

http://www.cypress.com/?rID=73537
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図 4-9. I
2
C F-RAMスレーブ デバイス アドレス レジスタ 

 

メモリの書き込み 

すべての書き込みはスレーブ アドレスに続いてメモリ アドレスの順で始まります。バス マスターはスレーブ アドレスの LSB (

ビット) を「0」にセットすることで書き込み動作であることを示します。アドレス指定した後、バス マスターは 1データ バイトずつメモ

リに送信して、メモリはアクノリッジ条件を生成します。連続バイトはいくつでも書き込めます。アドレス範囲の終わりに内部で達し

た場合、アドレス カウンタは 7FFFhから 0000hにラップアップします。 

シングルバイト書き込み: 

図 4-10. I
2
C F-RAM メモリのシングルバイト書き込み 

 

マルチバイト書き込み: 

図 4-11. I
2
C F-RAMマルチシステム メモリ書き込み 

 

メモリ読み出し 

読み出し動作には、現時点のアドレス読み出しと選択的な (ランダム) アドレス読み出しという 2 つの基本的なタイプがあります。

現時点のアドレス読み出しでは、FM24W256は内部アドレス ラッチを使用してアドレスを提供します。選択的読み出しでは、ユー

ザーはアドレスを特定の値に設定する手順を行います。  

現時点のアドレス読み出しと連続読み出し 

FM24W256は内部ラッチを使用して読み出しアドレスを指定します。現時点のアドレス読み出しは、アドレス ラッチ内の既存の値

を読み出し動作の開始点として使用します。システムは、直近の動作のアドレス直後に続くアドレスから読み出します。 

現時点のアドレス読み出しを行うために、バス マスターは LSB が「1」にセットされたスレーブ アドレスを提供します。これは読み

出し動作が要求されることを示します。完全なスレーブ アドレスを受信した後、FM24W256 は次のクロックで現時点のアドレスか

らデータをシフトアウトし始めます。現時点のアドレスは内部アドレス ラッチで保持されている値です。 

現時点のアドレスを冒頭に、バス マスターはバイトをいくつでも読み出せます。従って連続読み出しは単に複数バイトを転送する

現時点のアドレス読み出しです。各バイト転送の後、内部アドレス カウンターはインクリメントされます。 
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図 4-12. I
2
C F-RAMシングル バイト現時点のアドレス読み出し 

 

図 4-13. I
2
C F-RAMマルチシステム連続読み出し 

 

選択的 (ランダム) 読み出し 

ランダムなアドレスを読み出し動作の開始点に設定する簡単な方法があります。これは、書き込み動作の冒頭 3 バイトを使って

内部アドレスをセットし、続いて読み出し動作を行うことで実現します。 

選択的読み出しを行うために、バス マスターは LSB ( ) が 0にセットされたスレーブ アドレスを送信します。これは書き込み

動作を示します。書き込みプロトコルに従って、バス マスターはそれに続き、内部アドレス ラッチにロードされるアドレス バイトを

送信します。FM24W256がアドレスをアクノリッジした後、バス マスターは START条件を発行します。これにより、書き込み動作

が中止されると同時に、LSBが「1」にセットされたスレーブ アドレスで読み出しコマンドが発行されます。これで、動作は現時点の

アドレス読み出しとなります。 

図 4-14. F-RAM I
2
C選択的 (ランダム) 読み出し 
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5.   サンプル プロジェクト 

 

 

サイプレスが提供する CY15FRAMKIT-001シリアル F-RAM DVKパッケージには 4つのサンプル プロジェクトが組み込まれま

す。これらのサンプル プロジェクトにより、ユーザーはマイクロコントローラーとのシリアル F-RAM インターフェースを理解できま

す。サンプル プロジェクトは PSoC 4 Pioneer Kitと Arduino UNO R3キットに基づきます。 

www.cypress.com/go/CY15FRAMKIT-001 からサンプル プロジェクトをダウンロードします。インストーラはサンプル プロジェク

トを<Install_Directory>\CY15FRAMKIT-001 Serial F-RAM Kit\1.0\Firmware\フォルダに配置します。 

以下のサンプル プロジェクトは PSoC 4ベースのプロジェクトで、PSoC Creatorソフトウェアと PSoC 4 Pioneer Kitを必要としま

す。 

 PSoC4_FRAM_SPI 

 PSoC4_FRAM_I2C 

以下のサンプル プロジェクトは Arduinoベースのプロジェクトで、Arduino IDEと Arduino UNO R3キットを必要とします。 

 Arduino_FRAM_SPI 

 Arduino_FRAM_I2C 

5.1   PSoC 4 Pioneer Kitのプログラミング 

PSoC 4サンプル プロジェクトをプログラムするには以下の手順に従ってください (この手順では PSoC4_FRAM_SPIプロジェク

トが例として使われます)。 

1. Start > All Programs > Cypress > PSoC Creator 3.1 > PSoC Creator 3.1から PSoC Creatorを起動します。

PSoC Creatorがまだインストールされていない場合、www.cypress.com/psoccreatorからダウンロードします。 

2. 「Start Page」の Examples and Kitsセクションで Kits > CY15FRAMKIT-001を選択します。図 5-1に示しているよ

うに、サンプル プロジェクトの一覧が表示されます。所望のサンプル プロジェクトをクリックします。 

http://kohima.ad.iwpc.cypress.com/updates/cy15framkit/1.0/CY15FRAMKITSetup.exe
http://www.cypress.com/psoccreator
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図 5-1. PSoC Creatorでサンプル プロジェクトを開く 

 

3. プロジェクトを保存したいフォルダを選択して OKをクリックします。 

4. Build > Build <プロジェクト名>をクリックして、hexファイルを生成することで、コード例をコンパイルします。 

図 5-2. PSoC Creatorでプロジェクトをコンパイルする 

 

5. 動作電圧を選択します。CY15FRAMKIT-001 はジャンパ J5 経由の選択で 3.3V と 5.0V のどちらかで動作できます。

工場出荷時のジャンパのデフォルト設定は 5.0Vです (ピン 1とピン 2を短絡)。Arduino UNO R3基板は 5.0Vで動作

し、ジャンパ J5のデフォルト設定を適用します。CY8CKIT-042 Pioneer Kitは 3.3V と 5.0Vのどちらかで動作します。

Pioneer Kitのデフォルト設定は 3.3Vです。よって、親基板の電圧設定により、ジャンパ J5を 5.0V (ピン 1 とピン 2を

短絡) または 3.3V (ピン 2とピン 3を短絡) に設定します。PSoC 4をプログラムするには、図 5-3に示すように、USB

ミニ Bコネクタ J10に接続した USBケーブルを使って Pioneer基板を PCに接続します。  



 サンプル プロジェクト 

CY15FRAMKIT-001シリアル F-RAM開発キット ガイド、文書番号: 001-97580 Rev. ** 27 

図 5-3. USBを介して PSoC 4 Pioneer Kitを PCに接続 

 

6. PSoC Creatorで Debug > Programをクリックします。 

図 5-4. PSoC Creatorでデバイスをプログラム 

 

7. デバイスがまだ選択されていなければ、PSoC Creator は Programming ウィンドウを開きます。 KitProg を選択して

Port Acquireボタンをクリックします。 

図 5-5. PSoC Creatorでデバイスを選択 

 

8. デバイスは、選択された後、KitProgの下に階層構造で表示されます。そして、Connectボタンをクリックします。 
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図 5-6. PSoC Creatorでデバイスに接続 

 

9. OKをクリックして、ウィンドウを閉じると、書込みが始まります。 

図 5-7. PSoC Creatorでデバイスをプログラム 

 

5.2   UARTの設定 

本節では、シリアル COM接続用にハイパーターミナル、またはハイパーターミナルの代わりに PuTTYを使用して PSoC 4サン

プル プロジェクトの出力を PCに表示するための UARTインターフェースの設定について説明します。  

PSoC 4 Pioneer Kitの PSoC 5LPデバイスは図 5-8に示すように USB-UARTブリッジとして設定できます。PSoC 4サンプル 

プロジェクトの両方は USBポートを介して結果を PCに送信するための UART通信プロトコルを含んでいます。ハードウェア設

定およびアーキテクチャの詳細については、PSoC 4 Pioneer Kitのウェブ ページ (http://www.cypress.com/?rid=77780) を参

照してください。 

http://www.cypress.com/?rid=77780
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図5-8. PSoC4とPSoC 5LP間のUART接続のブロック図 

 

CY15FRAMKIT-001キット上のJ4_1 (SI) を介してアクセス可能なPSoC 4のRXポートをJ8_10 (TX) に接続します。

同様に、CY15FRAMKIT-001キットのJ4_2 (SO) を介してアクセス可能なPSoC 4のTXポートをJ8_9に接続します 

(図5-9を参照)。 

図 5-9. PSoC 4 Pioneer Kit上の UART接続 

  

USB ミニ Bを J10に接続します。キットは KitProg USB-UART として認識され、Device Manager > Ports (COM & LPT) の

下に表示します。 KitProg USB-UARTには 1個の通信ポートが割り当てられます。 
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図5-10. Device ManagerでのKitProg USB-UART  

 

次の節では、PC上のハイパーターミナルまたは PuTTYを PSoC 4 Pioneer Kitとの通信用に使用してシリアル接続を設定する

手順を説明します。 

5.2.1   ハイパーターミナルの設定  

ハイパーターミナルを開き、File > New Connectionを選択し、新しい接続の「名前」を入力して、OKをクリックします。 

図 5-11. 新しい接続を開く 
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1. 通信ポートを選択できる新しいウィンドウが開きます。 

Connect usingで適切な通信ポート「COMX」 (または KitProg USB-UARTに割り当てられた特有の通信ポート) を選

択して、OKをクリックして、ハイパーターミナルの次の設定に進みます。  

このサンプル コードでは COM5を使用します。ユーザーのセットアップ用の COM設定を検証して適切な COMXを選

択します。  

図 5-12. 通信ポートを選択 

 

2. COMX Propertiesウィンドウが開きます。図 5-13に示すように、このウィンドウの Port Settings タブで Restore 

Defaultsをクリックして、「Bits per second」、「Data bits」、「Parity」、「Stop bits」および「Flow control」パラメーターを

設定して、OKをクリックします。 サンプル プロジェクトでの PSoC 4 UARTポート設定を変更すれば、それと同じ設定

をハイパーターミナルで適用することを確認してください。OK をクリックして、通信を開始します。 

図 5-13. 通信ポートを設定 
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3. ハイパーターミナル ウィンドウが開き、PSoC 4のサンプル プロジェクトの出力がこのウィンドウに表示されます。 

図 5-14. 通信ポートを設定 

 

 

5.2.2   PuTTYの設定  

PuTTYはウィンドウズ用のフリーの SSHと Telnetクライアントです。www.putty.org/から PuTTYをダウンロードできます。 

1. PuTTYアイコンをダブルクリックして、Connection下の Serialを選択します。 

図 5-15. 新しい接続を開く 

 

http://www.putty.org/
../../../../../phuongbtt1/Documents/My%20Received%20Files/www.putty.org/
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2. 通信ポートを選択できる新しいウィンドウが開きます。Serial line to connect to フィールドに COMXを入力します。こ

のサンプル コードでは COM5を使用します。ユーザーのセットアップ用の COM設定を検証して適切な COMXを選択

します。  

Configure the serial line下の Speed (baud)、Data bits、Stop bits、Parityおよび Flow controlを選択します。

Session をクリックして、Connection type下の Serial を選択します。 

図 5-16. 通信ポートを選択・設定 

 

3. Category 下の Sessionを選択して、Communication type: を「Serial」に設定します。Openをクリックします。 

図 5-17. PuTTYで通信タイプを選択 
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4. COM端末ソフトウェアは PSoC 4からのデータを表示します。例えば、SPIサンプル プロジェクトの初期画面が図 5-18

に示されます。 

図 5-18. PuTTY に表示するデータ 

 

5.3   プロジェクト: PSoC 4 F-RAM SPI 

5.3.1   プロジェクトの説明 

このサンプル プロジェクトが CY8CKIT-042 PSoC 4 Pioneer Kitで実行され、SPI F-RAMコンポーネント、および F-RAM メモ

リ／ステータス レジスタの読み出しと書き込みをするための APIを提供します。サンプル プロジェクトでは、F-RAMへの書き込

みと、F-RAMからの読み出しを行って、PSoC 4での RGB LED (D9) を青色で点灯することで動作が成功したことを示します。

出力も UARTを介してハイパーターミナルに表示されます。 

5.3.2   ハードウェア接続 

UART設定については、5.2  を参照してください。 その他の接続はすべて基板上にハードワイヤ接続されます。ワークスペース 

エクスプローラで、PSoC4_FRAM_SPI.cydwrを開いて、適切なピンを選択します。 

表 5-1. PSoC 4 F-RAM SPI I/Oピン配置 

F-RAM I/O PSoC 4のピン 

CS# P3_4 

SI P3_0 

SO P3_1 

SCK P0_6 
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図 5-19. PSoC 4 F-RAM SPIサンプル プロジェクトのピン設定 

 

5.3.3   ファームウェア フロー 

以下の手順はサンプル プロジェクトのファームウェア フローを提供します。  

a. F-RAM SPIおよび USB-UARTブロックを初期化します。 

b. ディスプレイ (ハイパーターミナル／PuTTY) からの「Enter」キーを待機します。 

c. EXAMPLE_DATA_BYTE (0xA5) を EXAMPLE_ADDR_1 (0x2000) アドレスに書き込みます。 

d. EXAMPLE_ADDR_1 (0x2000) アドレスから 1バイトを読み出して、fram_rd_byteに格納します。 

e. EXAMPLE_DATA_BYTE (0xA5) を EXAMPLE_ADDR_1 (0x2000) アドレスに書き込みます。 

f. EXAMPLE_ADDR_1 (0x2000) アドレスから 1バイトを読み出して、fram_rd_byte変数に格納します。 

g. data_bytesアレイ (1、2、3、…、16) からのデータの 16バイトを EXAMPLE_ADDR_2 (0x3456) アドレスに書き込みます。 

h. 読み出し関数で EXAMPLE_ADDR_2 (0x3456) アドレスから 16バイトのデータを読み出します。 

i. EXAMPLE_STS_REG_VALUE (0x08) をステータス レジスタに書き込みます。 

j. ステータス レジスタを読み出して、その値を「statug_reg」変数に格納します。 

k. 読み出したデータを書き込んだデータと比較します。比較値が一致した場合、青色 LEDが点灯します。 

l. ステータス レジスタをクリアします。 

5.3.4   出力の検証 

データ出力は図 5-20および図 5-22に示されます。  
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図 5-20. PSoC 4 F-RAM SPIサンプル プロジェクトの出力 - ユーザーが押した Enter Key の待機中 

 

 

図 5-21. PSoC 4 F-RAM SPIサンプル プロジェクトの出力データ 

 

5.3.5   プロジェクトの変更 

プロジェクトの Source Filesフォルダ下のmain.cファイルを開いて、図 5-22に示す EXAMPLE_ADDR_1、

EXAMPLE_ADDR_2と EXAMPLE_DATA_BYTE変数を設定することでアドレスとデータ バイト値を変更します。例えば、 

0x2000を 0x1200に、0x3456を 0x1600に、0xa5 を 0x5aに変更します。 
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図 5-22.main.c ソース ファイルのスナップショット 

 

また、ユーザーは図 5-23に示すバースト書き込みデータを変更することもできます。 例えば、83行目での i+1を i+3に変更す

ると、0x03～0x13の入力データが初期化されます。 

図 5-23. 入力データ バッファ初期化用のmain.c ソース ファイルのスナップショット 

 

上記の変更をした後のプロジェクトをビルドして、Pioneer Kitをプログラムします。図 5-24に示しているように、0x1200アドレス

に書き込んだ 0x5aデータ、および 0x1600アドレスから書き込まれた 0x03 – 0x13データが出力に表示されます。次の節に説

明する APIは異なるアプリケーションをビルドするために使用できます。 

図 5-24. 変更した SPI F-RAMプロジェクトの出力 
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5.3.6   API 

5.3.6.1 void FRAM_SPI_Init(void) 

説明: SPIブロックを初期化する。  

パラメーター: なし 

返り値: なし 

注意事項:  なし 

5.3.6.2 uint8 FRAM_SPI_Write(uint32 addr、uint8 data_write) 

説明: 1バイトのデータを F-RAMに書き込む。  

パラメーター: uint32 addr: 書き込み用の 32ビット F-RAMアドレス 

uint8 data_write: 書き込まれるデータ バイト 

返り値: uint8: 0 - 通信エラー 

1 – 成功 

注意事項:  なし 

5.3.6.3 uint8 FRAM_SPI_Read(uint32 addr、uint8 *data_read) 

説明: F-RAMから 1バイトのデータを呼び出す。  

パラメーター: uint32 addr : 読み出し用の 32ビット F-RAMアドレス 

uint8 *data_read. : データを格納するための 8ビットのポインタ変数 

返り値: uint8: 0 – 通信エラー 

1 – 成功 

注意事項:  なし 

5.3.6.4 uint8 FRAM_SPI_BurstWrite(uint32 addr 、 uint8 *data_write_ptr 、 uint32 

total_data_count) 

説明: F-RAMにデータの total_data_count数を書き込む。  

パラメーター: uint32 addr: 書き込み用の 32ビット F-RAMアドレス 

uint8 *data_write_ptr: 書き込みデータ バイトのアレイへのポインタ 

uint32 total_data_count: 書き込みデータ バイト数 

返り値: uint8: 0 – 通信エラー 

1 – 成功 

注意事項:  なし 

5.3.6.5 uint8 FRAM_SPI_BurstRead(uint32 addr 、 uint8 *data_read_ptr 、 uint32 

total_data_count ) 

説明: F-RAMからデータの total_data_count数を読み出す。  

パラメーター: uint32 addr : 読み出し用の 32ビット F-RAMアドレス 

uint8 *data_read_ptr: データ バイトを格納するのに使用するアレイへのポインタ 
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uint32 total_data_count: 書き込みデータ バイト数 

返り値: uint8: 0 – 通信エラー 

1 – 成功 

注意事項:  なし 

5.3.6.6 uint8 FRAM_SPI_ Status_Reg_Write (uint8 data_byte) 

説明: F-RAMステータス レジスタ書き込み。 

パラメーター: uint8 data_byte -> 書き込まれる 1バイトのステータス レジスタ データ 

返り値: uint8: 0 – 通信エラー 

1 – 成功 

注意事項:  なし 

5.3.6.7 uint8 FRAM_SPI_ Status_Reg_Read (uint8 * status) 

説明: F-RAMステータス レジスタ読み出し。 

パラメーター: uint8 * status : ステータスレジスタに格納する値へのポインタ 

返り値: uint8: 0 – 通信エラー 

1 – 成功 

注意事項:  なし 

5.4   プロジェクト: PSoC 4 F-RAM I2C 

5.4.1   プロジェクトの説明 

このサンプル プロジェクトが CY8CKIT-042 PSoC 4 Pioneer Kitで実行され、I
2
C F-RAMコンポーネントおよび、F-RAM メモリ

の読み出しと書き込みをするための APIを提供します。サンプル プロジェクトでは、F-RAMへの書き込みと、F-RAMからの読み

出しを行って、PSoC 4での RGB LED (D9) を青色で点灯することで動作が成功したことを示します。出力も UARTを介してハイ

パーターミナルに表示されます。 

5.4.2   ハードウェア接続 

UART設定については、5.2  を参照してください。その他の接続はすべて基板上にハードワイヤ接続されます。ワークスペース 

エクスプローラで、PSoC4_FRAM_I2C.cydwrを開いて、適切なピンを選択します。 

表 5-2. PSoC 4 F-RAM I
2
C I/Oピン配置 

F-RAM I/O PSoC 4のピン 

SDA P4_1 

SCL P4_0 
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図 5-25. PSoC 4 F-RAM I
2
Cサンプル プロジェクトのピン設定 

 

5.4.3   ファームウェア フロー 

以下の手順はサンプル プロジェクトのファームウェア フローを提供します。  

a. F-RAM I
2
Cおよび USB-UARTブロックを初期化します。 

b. EXAMPLE_DATA_BYTE (0xA5) を EXAMPLE_ADDR_1 (0x2000) アドレスに書き込みます。 

c. EXAMPLE_ADDR_1 (0x2000) アドレスから 1バイトを読み出して、fram_rd_byte変数に格納します。 

d. data_bytesアレイ (1、2、3、…、16) からの 16バイトのデータを EXAMPLE_ADDR_2 (0x3456) アドレスに書き込みます。 

e. ランダム読み出し関数で EXAMPLE_ADDR_2 (0x3456) アドレスからデータの 15バイトを読み出します。 

f. 現在の読み出し関数で 16バイト目を読み出します。 

g. 読み出しデータを書き込みデータと比較し、読み出しに成功すれば、青色 LEDが点灯します。 

 

5.4.4   出力の検証 

読み出しが成功した場合、RGB LEDは青色で点灯します。読み出しに失敗した場合、RGB LEDは点灯しません。データ出力は

図 5-26および図 5-27に示されます。 

図 5-26. PSoC 4 F-RAM I
2
Cサンプル プロジェクトの出力 - ユーザーが押した Enter Keyの待機中 
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図 5-27. PSoC 4 F-RAM I
2
Cサンプル プロジェクトの出力データ 

 

5.4.5   プロジェクトの変更 

プロジェクトの Source Filesフォルダ下のmain.cファイルを開いて、図 5-28に示す EXAMPLE_ADDR_1、

EXAMPLE_ADDR_2および EXAMPLE_DATA_BYTEの値を変更します。例えば、0x2000を 0x1200に、0x3456を 0x1600

に、0xa5を 0x5aに変更します。 

図 5-28.main.c ソース ファイルのスナップショット 

 

また、ユーザーは図 5-29に示すバースト書き込みデータを変更することもできます。例えば、80行目での i+1を i+3に変更する

と、0x03～0x13の入力データが初期化されます。 

図 5-29. 入力データ バッファ初期化用のmain.c ソース ファイルのスナップショット 
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上記の変更をした後、プロジェクトをビルドしてキットをプログラムします。図 5-30に示しているように、0x1200アドレスに書き込

んだ 0x5aデータ、および 0x1600アドレスから書き込まれた 0x03 – 0x13データが出力に表示されます。次の節に説明する

APIは異なるアプリケーションをビルドするために使用できます。 

図 5-30. 変更した I
2
C F-RAMプロジェクトの出力 

 

 

5.4.6   API 

以下の APIは PSoC 4 F-RAM I
2
C用に定義されます。これらの APIは Arduino用のものと同じです。 

5.4.6.1 void FRAM_I2C_Init(void) 

説明: I2Cブロックを初期化する。  

パラメーター: なし 

返り値: なし 

注意事項:  なし 

5.4.6.2 uint32 FRAM_I2C_Write (uint8 slave_id、uint32 addr、uint8 *data_write_ptr、uint32 

total_data_count) 

説明: slave_idに指定される F-RAMにデータの total_data_count数を書き込む。  

パラメーター: uint8: 7ビットのスレーブ ID 

uint32 addr: 書き込み用の 32ビット F-RAMアドレス 

uint8 *data_write_ptr: 書き込みデータ バイトのアレイへのポインタ 

uint32 total_data_count: 書き込みデータ バイト数 

返り値: PSoC 4の場合、 

uint32: エラー ステータス 

FRAM_I2C_MSTR_NO_ERROR           -- (0x00u)        

        FRAM_I2C_MSTR_ERR_ARB_LOST  -- (0x01u) 

        FRAM_I2C_MSTR_ERR_LB_NAK        -- (0x02u)      

        FRAM_I2C_MSTR_NOT_READY         --  (0x04u) 
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        FRAM_I2C_MSTR_BUS_BUSY            -- (0x08u)      

        FRAM_I2C_MSTR_ ERR_ABORT_START    -- (0x10u) 

        FRAM_I2C_MSTR_ ERR_BUS_ERR             -- (0x100u) 

        FRAM_I2C_MSTR_ERR                                -- (0xFFu) 

Arduino UNOの場合、 

uint32: エラー ステータス 

成功 -- (0x00u) 

データが長くて送信バッファに入り切らない -- (0x01u) 

アドレスの送信時に NACKを受信 -- (0x02u)  

データの送信時に NACKを受信 -- (0x03u) 

その他のエラー -- (0x04u) 

注意事項:  なし 

5.4.6.3 uint32 FRAM_I2C_Current_Read (uint8 slave_id, uint8 *data_read_ptr, uint32 
total_data_count) 

説明: slave_idに指定される F-RAMの現在のアドレスからデータの total_data_count数を読

み出す。  

パラメーター: uint8: 7ビットのスレーブ ID 

uint8 *data_read_ptr: データ バイトを格納するのに使用するアレイへのポインタ 

uint32 total_data_count: 書き込みデータ バイト数 

返り値: PSoC 4の場合、 

uint32: エラー ステータス 

        FRAM_I2C_MSTR_NO_ERROR           -- (0x00u)        

        FRAM_I2C_MSTR_ERR_ARB_LOST  -- (0x01u) 

        FRAM_I2C_MSTR_ERR_LB_NAK        -- (0x02u)      

        FRAM_I2C_MSTR_NOT_READY         --  (0x04u) 

        FRAM_I2C_MSTR_BUS_BUSY            -- (0x08u)      

        FRAM_I2C_MSTR_ ERR_ABORT_START    -- (0x10u) 

        FRAM_I2C_MSTR_ ERR_BUS_ERR             -- (0x100u) 

        FRAM_I2C_MSTR_ERR                                -- (0xFFu) 

Arduino UNOの場合、読み出されたバイト数を返す。 

注意事項:  なし 

5.4.6.4 uint32 FRAM_ I2C_Random_Read (uint8 slave_id, uint32 addr, uint8 *data_read_ptr, 
uint32 total_data_count) 

説明: slave_idに指定される F-RAMからデータの total_data_count数を読み出す。  

パラメーター: uint8: 7ビットのスレーブ ID 

uint32 addr: 読み出し用の 32ビット F-RAMアドレス 

uint8 *data_read_ptr: データ バイトを格納するのに使用するアレイへのポインタ 
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uint32 total_data_count: 書き込みデータ バイト数 

返り値: PSoC 4の場合、 

uint32: エラー ステータス 

        FRAM_I2C_MSTR_NO_ERROR           -- (0x00u)        

        FRAM_I2C_MSTR_ERR_ARB_LOST  -- (0x01u) 

        FRAM_I2C_MSTR_ERR_LB_NAK        -- (0x02u)      

        FRAM_I2C_MSTR_NOT_READY         --  (0x04u) 

        FRAM_I2C_MSTR_BUS_BUSY            -- (0x08u)      

        FRAM_I2C_MSTR_ ERR_ABORT_START    -- (0x10u) 

        FRAM_I2C_MSTR_ ERR_BUS_ERR             -- (0x100u) 

        FRAM_I2C_MSTR_ERR                                -- (0xFFu) 

Arduino UNOの場合、読み出されたバイト数を返す。 

注意事項:  なし 

5.5   プログラミング Arduino UNOキット 

Arduinoサンプル プロジェクトをプログラムするには以下の手順に従ってください (この手順では Arduino_FRAM_SPIプロジェク

トが例として使われます)。 

1. Arduino IDE をインストールします。Arduino のウェブページから Arduino IDE ソフトウェアをダウンロードできます: 

http://arduino.cc/en/Main/Software。 

2. 「Arduino_FRAM_SPI」プロジェクト フォルダを開き、FRAM_SPI_Example.ino ファイルをダブルクリックします。 

図 5-31. Arduinoプロジェクト ファイルを開く 

 

3. コード例をコンパイルします: Sketch > Verify / Compile。正常なコンパイルの終了時に、IDEは「Done compiling.」ス

テータスを表示し、2進数のスケッチを生成します。 

図 5-32. Arduinoプロジェクトをコンパイル 

 

 

http://arduino.cc/en/Main/Software
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4. Arduino UNO キットをプログラムするには、図 5-33 に示すように、Arduino UNO 互換の USB ケーブルを使用して

USBポートを介して PC を Arduino基板に接続します。Arduino UNOキットが 5V で動作するため、5Vの電源を選択

するために CY15FRAMKIT-001 上の電源選択ジャンパ (J5) をピン 1 とピン 2 に配置することを確実に行ってください。 

図 5-33. Arduino UNO R3キットに取り付けた CY15FRAMKIT-001 

 

5. Uploadボタンをクリックして 2進数のスケッチ ファイルをアップロードします。 

図 5-34.Arduino UNO R3キットのプログラミング 

 

 

 

5.6   プロジェクト: Arduino F-RAM SPI 

5.6.1   プロジェクトの説明 

このサンプル プロジェクトは Arduino UNO基板で実行され、F-RAMメモリ／ステータス レジスタを読み出すおよび書き込むための

SPI APIを提供します。サンプル プロジェクトは F-RAMに書き込み、F-RAMから読み出し、結果を直列出力ウィンドウに表示します。 

5.6.2   ハードウェア接続 

すべての接続は基板上に配線でつなぐため、このプロジェクトには追加のハードウェア接続が不要です。Arduino SPIライブラリ

はデフォールトで次のピンを使用します。 
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表 5-3. Arduino F-RAM SPI I/Oピン配置 

F-RAM I/O Arduinoピン 

CS# D10 

SI D11 

SO D12 

SCK D13 

5.6.3   ファームウェア フロー 

以下の手順はサンプル プロジェクトのファームウェア フローを提供します。  

a. F-RAM SPIを初期化します。 

b. EXAMPLE_DATA_BYTE (0xA5) を EXAMPLE_ADDR_1 (0x2000) アドレスに書き込みます。直列出力に書き込んだ

データを表示します。 

c. EXAMPLE_ADDアドレスから 1バイトを読み出します。F-RAM SPIを初期化します。 

d. EXAMPLE_DATA_BYTE (0xA5) を EXAMPLE_ADDR_1 (0x2000) アドレスに書き込みます。直列出力に書き込んだ

データを表示します。 

e. EXAMPLE_ADDR_1 (0x2000) アドレスから 1 バイトを読み出して、fram_rd_byte 変数に格納します。直列出力に読み出

したデータを表示します。 

f. 書き込んだデータと読み出したデータを比較して、結果 (PASS/FAIL) を直列出力に表示します。 

g. data_bytesアレイ (1、2、3、…、16) からの 16バイトのデータを EXAMPLE_ADDR_2 (0x3456) アドレスに書き込みます。 

h. 読み出し関数で EXAMPLE_ADDR_2 (0x3456) アドレスから 16バイトのデータを読み出します。 

i. 書き込んだデータと読み出したデータを比較して、結果 (PASS/FAIL) を直列出力に表示します。 

j. EXAMPLE_STS_REG_VALUE (0x08) をステータス レジスタに書き込みます。 

k. ステータス レジスタを読み出して、その値を「statug_reg」変数に格納します。 

l. 書き込んだデータと読み出したデータを比較して、結果 (PASS/FAIL) を直列出力に表示します。 

m. ステータス レジスタをクリアします。 

5.6.4   出力の検証 

Tools >Serial Portを開き、図 5-35に示すように、通信に適切な COMポートを選択します。 

図 5-35. Arduino IDE内の直列ポート 
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図 5-36と図 5-37に示すように、Tools > Serial Monitorを開き、直列出力を表示させます。 

図 5-36. Arduino IDE内の直列モニター 

 

図 5-37. SPI F-RAMプロジェクト用のモニター出力 

 

5.6.5   API 

5.6.5.1 void FRAM_SPI_Init() 

説明: SPIライブラリを初期化する。 

パラメーター: なし 

返り値: なし 

注意事項:  なし 

5.6.5.2 void FRAM_SPI_Write (uint32 addr、uint8 data_write) 

説明: 1バイトのデータを F-RAMに書き込む。  

パラメーター: uint32 addr: 書き込み用の 32ビット F-RAMアドレス 

uint8 data_write: 書き込まれるデータ バイト 

返り値: なし 

注意事項:  なし 

5.6.5.3 uint8 FRAM_SPI_Read(uint32 addr) 

説明: F-RAMから 1バイトのデータを呼び出す。  

パラメーター: uint32 addr : 読み出し用の 32ビット F-RAMアドレス 

返り値: uint8 : 読み出されるデータ 

注意事項:  なし 
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5.6.5.4 void FRAM_SPI_BurstWrite(uint32 addr, uint8 *data_write_ptr, uint32 
total_data_count) 

説明: F-RAMにデータの total_data_count数を書き込む。  

パラメーター: uint32 addr: 書き込み用の 32ビット F-RAMアドレス 

uint8 *data_write_ptr: 書き込まれるデータ バイトのアレイへのポインタ 

uint32 total_data_count: 書き込まれるデータ バイト数 

返り値: なし 

注意事項:  なし 

5.6.5.5 void FRAM_SPI_BurstRead(uint32 addr, uint8 *data_read_ptr, uint32 
total_data_count ) 

説明: F-RAMからデータの total_data_count数を読み出す。  

パラメーター: uint32 addr : 読み出し用の 32ビット F-RAMアドレス 

uint8 *data_read_ptr: データ バイトを格納するのに使用するアレイへのポインタ 

uint32 total_data_count: 書き込みデータ バイト数 

返り値: なし 

注意事項:  なし 

5.6.5.6 void FRAM_SPI_ Status_Reg_Write (uint8 data_byte) 

説明: F-RAMステータス レジスタ書き込み。 

パラメーター: uint8 data_byte -> 書き込まれる 1バイトのステータス レジスタ データ 

返り値: なし 

注意事項:  なし 

5.6.5.7 uint8 FRAM_SPI_ Status_Reg_Read (void) 

説明: F-RAMステータス レジスタ読み出し。 

パラメーター: なし 

返り値: uint8: ステータス レジスタ データ 1バイト 

注意事項:  なし 

5.7   プロジェクト: Arduino F-RAM I2C 

5.7.1   プロジェクトの説明 

このサンプル プロジェクトは Arduino UNO基板で実行され、F-RAM メモリを読み出すおよび書き込むための I
2
C APIを提供し

ます。サンプル プロジェクトは F-RAMに書き込み、F-RAMから読み出し、結果を直列出力ウィンドウに表示します。 

5.7.2   ハードウェア接続 

すべての接続は基板上に配線でつなぐため、このプロジェクトには追加のハードウェア接続が不要です。Arduino WIREライブラ

リ (I
2
C) はデフォールトで次のピンを使用します。 
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表 5-4. Arduino F-RAM I
2
C I/Oピン配置 

F-RAM I/O Arduinoピン 

SDA A4 

SCL A5 

5.7.3   ファームウェア フロー 

以下の手順はサンプル プロジェクトのファームウェア フローを提供します。  

a. F-RAM I
2
Cを初期化して起動遅延を提供します。 

b. EXAMPLE_DATA_BYTE (0xA5) を EXAMPLE_ADDR_1 (0x2000) アドレスに書き込みます。 

c. EXAMPLE_ADDR_1 (0x2000) アドレスから 1 バイトを読み出して、fram_rd_byte 変数に格納します。直列出力に

読み出したデータを表示します。 

d. 書き込んだデータと読み出したデータを比較して、結果 (PASS/FAIL) を直列出力に表示します。 

e. data_bytesアレイ (1、2、3、…、16) からの 16バイトのデータを EXAMPLE_ADDR_2 (0x3456) アドレスに書き込

みます。 

f. ランダム読み出し関数で EXAMPLE_ADDR_2 (0x3456) アドレスからデータの 15バイトを読み出します。 

g. 現在の読み出し関数で 16バイト目を読み出します。 

h. 書き込んだデータと読み出したデータを比較して、結果 (PASS/FAIL) を直列出力に表示します。 

5.7.4   出力の検証 

図 5-38に示すように、ToolsSerial Monitorを開き、直列出力を表示させます。 

図 5-38. I
2
C F-RAMプロジェクト用のモニター出力 

 

 

5.7.5   API 

PSoC 4 I2C F-RAMの API説明と同様です。5.4.6  項を参照してください。 
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A.2 ピン割り当ての表 

本節では、ヘッダのピン マップとそれらの使用方法を記述します。 

Arduino互換のヘッダ (J1, J2, J3, J4) 

J1 

ピン Arduino信号 PSoC 4 Pioneer Kit信号 CY15FRAMKIT-001キット信号 

J1_1 VIN VIN NC 

J1_2 GND GND GND 

J1_3 GND GND GND 

J1_4 5V V5.0 5V 

J1_5 3.3V V3.3 3V3 

J1_6 RESET# RESET# RESET# 

J1_7 IOREF P4_VDD NC 

J1_8 NC NC NC 

 

J2 

ピン Arduino信号 PSoC 4 Pioneer Kit信号 CY15FRAMKIT-001キット信号 

J2_1 A0 P2[0] NC 

J2_2 A1 P2[1] NC 

J2_3 A2 P2[2] NC 

J2_4 A3 P2[3] NC 

J2_5 A4/SDA (I
2
C) P2[4] SDA 

J2_6 A5/SCL (I
2
C) P2[5] SCL 

 

J3 

ピン Arduino信号 PSoC 4 Pioneer Kit信号 CY15FRAMKIT-001キット信号 

J3_1 D8 P2[6] HOLD# (SPI F-RAM) 

J3_2 D9 (PWM) P3[6] WP# (SPI F-RAM) 

J3_3 D10 (PWM/SS) P3[4] / CS (SCB1) CS# (SPI F-RAM) 

J3_4 D11 (PWM / MOSI) P3[0] / MOSI (SCB1) SI 

J3_5 D12 (MISO) P3[1] / MISO (SCB1) SO 

J3_6 D13 (SCK) P0[6] / SCK (SCB1) SCK 

J3_7 GND GND GND 

J3_8 AREF P1[7] NC 

J3_9 SDA P4[1] / SDA (SCB0) SDA 

J3_10 SCL P4[0] / SCL (SCB0) SCL 
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J4 

ピン Arduino信号 PSoC 4 Pioneer Kit信号 CY15FRAMKIT-001キット信号 

J4_1 D0 (UART RX) P0[4] / SCL (SCB1) NC  

J4_2 D1 (UART TX) P0[5] / SDA (SCB1) NC 

J4_3 D2 P0[7] NC  

J4_4 D3 (PWM) P3[7] NC  

J4_5 D4 P0[0] NC  

J4_6 D5 (PWM) P3[5] NC  

J4_7 D6 (PWM) P1[0] NC  

J4_8 D7 P2[7] WP (I
2
C F-RAM) 

 

A.3 デバッグ ヘッダ I/O 

J6 

ピン デバッグ信号 

J6_1 SO 

J6_2 VDD 

J6_3 SCK 

J6_4 SI 

J6_5 RESET# 

J6_6 GND  

 

J7 

ピン デバッグ信号 

J7_1 SDA 

J7_2 SCL 

J7_3 CS# 

J7_4 GND 



 付録 

CY15FRAMKIT-001シリアル F-RAM開発キット ガイド、文書番号: 001-97580 Rev. ** 55 

A.4 0Ω抵抗と負荷なしの使用法 

単位 抵抗 使用法 

SPI F-RAMデバイス R5 コントローラーから SPI HOLD#ピンの制御用に 0Ω抵抗をはんだ付けする 

SPI F-RAMデバイス R6 コントローラーから SPI HOLD#ピンの制御用に 0Ω抵抗をはんだ付けする 

I
2
C F-RAMデバイス R11 コントローラーから I

2
C WP#ピンを制御する用に 0Ω抵抗をはんだ付けする 

 

A.5 30Ω抵抗と負荷なしの使用法 

単位 抵抗 使用法 

I
2
C通信 R9 

Arduino UNO R2基板上の I
2
C通信用に SDAアクセスするために、30Ω

抵抗をはんだ付けする 

I
2
C通信 R10 

Arduino UNO R2基板上の I
2
C通信用に SDAアクセスするために、30Ω

抵抗をはんだ付けする 

SPI通信 R21 

J4_1を SPI SIピンとして使用するために 30Ω抵抗をはんだ付けする。これ

により、J3_4上の SIが開放され、CY8CKIT-042 Pioneer Kitでの I
2
C-

USBブリッジ通信に使用されることが可能になる 

SPI通信 R22 

J4_2を SPI SOピンとして使用するために 30Ω抵抗をはんだ付けする。こ

れにより、J3_5上の SOが開放され、CY8CKIT-042 Pioneer Kitでの I
2
C-

USBブリッジ通信に使用されることが可能になる 
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A.6 部品表 (BOM) 

No. 数量 リファレンス 値 説明 メーカー メーカー部品番号 

1       

プリント基板、52.07mm 

X 53.59mm、2層、

ENIGめっき、高 Tg、青

色はんだ付けマスク、白

色シルクスクリーン  

サイプレス   

2 1 C1 10uF 
CAP TANT 10UF 10V 
20% 1206 

AVX Corporation TPSA106M010R1800 

3 3 C2、C4、C6 0.1uF 
CAP CER 0.1UF 50V 
Y5V 0603 

Murata 
Electronics 

GRM188R71C104KA
01D 

4 2 C3,C5 1uF 
CAP CERAMIC 1.0UF 
25V X5R 0603 10% 

太陽誘電 TMK107BJ105KA-T 

5 2 J1、J4 8x1 RECP 
CONN RCPT .100" 
8PS R/A SGL TIN 

Samtec Inc SSQ-108-03-T-S 

6 1 J2 6x1 RECP 
CONN RCPT .100" 
6POS SNGL TIN 

Samtec Inc SSQ-106-03-T-S 

7 1 J3 10x1 RECP 
CONN RCPT .100" 
10POS SNGL TIN 

Samtec Inc SSQ-110-03-T-S 

8 1 J5 3ピン ヘッダ  
CONN HEADER 
VERT SGL 3POS 
GOLD 

3M 961103-6404-AR 

9 1 LED1 
電動 LED 

青色 

LED GREEN CLEAR 
0805 SMD 

Chicago 
Miniature 

CMD17-21VGC/TR8 

10 1 R1 0E 
RES 0.0 OHM 1/8W 
JUMP 0805 SMD 

Panasonic - ECG ERJ-6GEY0R00V 

11 1 R2 220オーム 
RES 220 OHM 1/10W 
5% 0603 SMD 

Panasonic - ECG ERJ-3GEYJ221V 

12 8 

R3、R4、R7、R8、

R12、R13、R14、
R15 

4.7k 
RES 4.7K OHM 1/10W 
5% 0603 SMD 

Panasonic - ECG ERJ-3GEYJ472V 

13 5 
R16、R17、R18、

R19、R20 
30オーム 

RES SMD 30 OHM 5% 
1/10W 0603 

Panasonic - ECG ERJ-3GEYJ300V 

14 1 SW1 3-POS DIP 
SW DIP SLIDE SPST 
3 POS UNSEALD 

E-Switch KAS1103E 

15 1 TVS1 5V 350W 
TVS DIODE 5VWM 
14.5VC SOD323 

Diodes 
Incorporated 

SD05-7 

16 1 U1 SPI F-RAM 
IC FRAM 256-KBIT 
40MHZ 8SOIC 

サイプレス FM25W256-G 

17 1 U2 I2C F-RAM 
IC FRAM 256-KBIT 
3.4MHZ 8SOIC 

サイプレス FM24W256-G 

18 1 該当なし ジャンパ ジャンパ 3M 969102-0000-DA 

負荷なしコンポーネント 

19 1 J6 
3X2 CONN 
FEMALE 

CONN HEADER 
VERT DUAL 6POS 
GOLD 

3M 961206-6404-AR 

20 1 J7 
2X2 CONN 
FEMALE 

CONN HEADER 
VERT DUAL 4POS 
GOLD 

3M 961204-6404-AR 

21 3 R5、R6、R11 0E 
RES 0.0 OHM 1/10W 
0603 SMD 

Panasonic - ECG ERJ-3GEYJ302V 

22 4 
R9、R10、R21、
R22 

30E 
RES SMD 30 OHM 5% 
1/10W 0603 

Panasonic - ECG ERJ-3GEYJ300V 

https://www.sparkfun.com/products/9279
https://www.sparkfun.com/products/9279
https://www.sparkfun.com/products/9279
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No. 数量 リファレンス 値 説明 メーカー メーカー部品番号 

23 3 TP1、TP2、TP3 黒色 
TEST POINT PC MINI 
.040"D Black 

Keystone 
Electronics 

5001 

特別ジャンパのインストールの指示 

24 1 J5 

ジャンパをピ

ン 1 とピン 2 

の間に取り付

ける  

ヘッダ&ワイヤ ハウジン

グ 2.54MMシャント  
3M 969102-0000-DA 

ラベル 

25 1 該当なし 該当なし 

LBL、PCAラベル、ベン

ダ コード、日付コード、

シリアル番号 121-

60201-01 REV 01 
(YYWWVVXXXXX) 

サイプレス   

26 1 該当なし 該当なし 

LBL、CY15FRAMKIT-

001 QRコード、12mm 

X 12mm 

サイプレス   

27 1 該当なし 該当なし 

LBL、静電気防止警告、

ULINE PN S-6516、

5/8" x 2"、「Attention 

Observe Precautions」 

サイプレス   
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改訂履歴 
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